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~ WARNING ~
Thank you for purchasing automation equipment from Automationdirect.com®, doing business as, 
AutomationDirect. We want your new automation equipment to operate safely. Anyone who installs or 
uses this equipment should read this publication (and any other relevant publications) before installing 
or operating the equipment.
To minimize the risk of potential safety problems, you should follow all applicable local and national 
codes that regulate the installation and operation of your equipment. These codes vary from area 
to area and usually change with time. It is your responsibility to determine which codes should be 
followed, and to verify that the equipment, installation, and operation is in compliance with the latest 
revision of these codes.
At a minimum, you should follow all applicable sections of the National Fire Code, National Electrical 
Code, and the codes of the National Electrical Manufacturer’s Association (NEMA). There may be local 
regulatory or government offices that can also help determine which codes and standards are necessary 
for safe installation and operation.
Equipment damage or serious injury to personnel can result from the failure to follow all applicable 
codes and standards. We do not guarantee the products described in this publication are suitable for 
your particular application, nor do we assume any responsibility for your product design, installation, or 
operation.
Our products are not fault-tolerant and are not designed, manufactured or intended for use or resale 
as on-line control equipment in hazardous environments requiring fail-safe performance, such as in the 
operation of nuclear facilities, aircraft navigation or communication systems, air traffic control, direct life 
support machines, or weapons systems, in which the failure of the product could lead directly to death, 
personal injury, or severe physical or environmental damage (“High Risk Activities”). AutomationDirect 
specifically disclaims any expressed or implied warranty of fitness for High Risk Activities.
For additional warranty and safety information, see the Terms and Conditions section of our catalog. 
If you have any questions concerning the installation or operation of this equipment, or if you need 
additional information, please call us at 770-844-4200.
This publication is based on information that was available at the time it was printed. At 
AutomationDirect we constantly strive to improve our products and services, so we reserve the right 
to make changes to the products and/or publications at any time without notice and without any 
obligation. This publication may also discuss features that may not be available in certain revisions of 
the product.

Trademarks
This publication may contain references to products produced and/or offered by other companies. The product and company names 
may be trademarked and are the sole property of their respective owners. AutomationDirect disclaims any proprietary interest in the 
marks and names of others.

Copyright© 2024, Automationdirect.com® Incorporated 
All Rights Reserved

No part of this manual shall be copied, reproduced, or transmitted in any way without the prior, written consent of Automationdirect.
com® Incorporated. AutomationDirect retains the exclusive rights to all information included in this document.



~ ADVERTENCIA ~
Gracias por comprar equipo de automatización de Automationdirect.com®. Deseamos que su nuevo 
equipo de automatización opere de manera segura. Cualquier persona que instale o use este equipo 
debe leer esta publicación (y cualquier otra publicación pertinente) antes de instalar u operar el 
equipo.
Para reducir al mínimo el riesgo debido a problemas de seguridad, debe seguir todos los códigos 
de seguridad locales o nacionales aplicables  que regulan la instalación y operación de su equipo. 
Estos códigos varian de área en área y usualmente cambian con el tiempo. Es su responsabilidad  
determinar cuales códigos deben ser seguidos y verificar que el equipo, instalación y operación estén 
en cumplimiento con la revisión mas reciente de estos códigos.
Como mínimo, debe seguir las secciones aplicables del Código Nacional de Incendio, Código Nacional 
Eléctrico, y los códigos de (NEMA) la Asociación Nacional de Fabricantes Eléctricos  de USA. Puede 
haber oficinas de normas locales o del gobierno que pueden ayudar a determinar cuales códigos y 
normas son necesarios para una instalación y operación segura.
Si no se siguen todos los códigos y normas aplicables, puede resultar en daños al equipo o lesiones 
serias a personas.  No garantizamos los productos descritos en esta publicación para ser adecuados 
para su aplicación en particular, ni asumimos ninguna responsabilidad por el diseño de su producto, 
la instalación u operación.
Nuestros productos no son tolerantes a fallas y no han sido diseñados, fabricados o intencionados 
para uso o reventa como equipo de control en línea en ambientes  peligrosos que requieren una 
ejecución sin fallas, tales como operación en instalaciones nucleares, sistemas de navegación aérea, o 
de comunicación, control de tráfico aéreo,  máquinas de soporte de vida o sistemas de armamentos 
en las cuales la falla del producto puede resultar directamente en muerte, heridas personales, o daños 
físicos o ambientales severos (“Actividades de Alto Riesgo”).  Automationdirect.com específicamente 
rechaza cualquier garantía ya sea expresada o implicada para actividades de alto riesgo.		   
 
Para información adicional acerca de garantía e información de seguridad, vea la sección de Términos 
y Condiciones de nuestro catálogo.  Si tiene alguna pregunta sobre instalación u operación de este 
equipo, o si necesita información adicional, por favor llámenos al  número 770-844-4200 en Estados 
Unidos.	  
Esta publicación está basada en la información disponible al momento de impresión.  En 
Automationdirect.com nos esforzamos constantemente para mejorar nuestros productos y servicios, 
así que nos reservamos el derecho de hacer cambios al producto y/o a las publicaciones en cualquier 
momento sin notificación  y sin ninguna obligación.  Esta publicación también puede discutir 
características que no estén disponibles en ciertas revisiones del producto.

Marcas Registradas
Esta publicación puede contener referencias a productos producidos y/u ofrecidos por otras compañías.  Los nombres de las 
compañías y productos pueden tener marcas registradas y son propiedad única de sus respectivos dueños.  Automationdirect.com, 
renuncia cualquier interés propietario en las marcas y nombres de otros.

Propiedad Literaria© 2024, Automationdirect.com® Incorporated
Todos los derechos reservados

No se permite copiar, reproducir, o transmitir de ninguna forma ninguna parte de este manual sin previo consentimiento por escrito 
de Automationdirect.com® Incorprated.  Automationdirect.com retiene los derechos exclusivos a toda la información incluida en este 
documento. Los usuarios de este equipo pueden copiar este documento  solamente para instalar, configurar y mantener el equipo 
correspondiente. También las instituciones de enseñanza pueden usar este manual para propósitos educativos.



~ AVERTISSEMENT ~
Nous vous remercions d’avoir acheté l’équipement d’automatisation de Automationdirect.com®, 
en faisant des affaires comme, AutomationDirect. Nous tenons à ce que votre nouvel équipement 
d’automatisation fonctionne en toute sécurité. Toute personne qui installe ou utilise cet équipement 
doit lire la présente publication (et toutes les autres publications pertinentes) avant de l’installer ou de 
l’utiliser.
Afin de réduire au minimum le risque d’éventuels problèmes de sécurité, vous devez respecter 
tous les codes locaux et nationaux applicables régissant l’installation et le fonctionnement de votre 
équipement. Ces codes diffèrent d’une région à l’autre et, habituellement, évoluent au fil du temps. Il 
vous incombe de déterminer les codes à respecter et de vous assurer que l’équipement, l’installation 
et le fonctionnement sont conformes aux exigences de la version la plus récente de ces codes.
Vous devez, à tout le moins, respecter toutes les sections applicables du Code national de prévention 
des incendies, du Code national de l’électricité et des codes de la National Electrical Manufacturer’s 
Association (NEMA). Des organismes de réglementation ou des services gouvernementaux locaux 
peuvent également vous aider à déterminer les codes ainsi que les normes à respecter pour assurer 
une installation et un fonctionnement sûrs. 
L’omission de respecter la totalité des codes et des normes applicables peut entraîner des dommages 
à l’équipement ou causer de graves blessures au personnel. Nous ne garantissons pas que les produits 
décrits dans cette publication conviennent à votre application particulière et nous n’assumons aucune 
responsabilité à l’égard de la conception, de l’installation ou du fonctionnement de votre produit.
Nos produits ne sont pas insensibles aux défaillances et ne sont ni conçus ni fabriqués pour 
l’utilisation ou la revente en tant qu’équipement de commande en ligne dans des environnements 
dangereux nécessitant une sécurité absolue, par exemple, l’exploitation d’installations nucléaires, 
les systèmes de navigation aérienne ou de communication, le contrôle de la circulation aérienne, 
les équipements de survie ou les systèmes d’armes, pour lesquels la défaillance du produit peut 
provoquer la mort, des blessures corporelles ou de graves dommages matériels ou environnementaux 
(«activités à risque élevé»). La société AutomationDirect nie toute garantie expresse ou implicite 
d’aptitude à l’emploi en ce qui a trait aux activités à risque élevé.
Pour des renseignements additionnels touchant la garantie et la sécurité, veuillez consulter la section 
Modalités et conditions de notre documentation. Si vous avez des questions au sujet de l’installation 
ou du fonctionnement de cet équipement, ou encore si vous avez besoin de renseignements 
supplémentaires, n’hésitez pas à nous téléphoner au 770-844-4200.
Cette publication s’appuie sur l’information qui était disponible au moment de l’impression. À la 
société AutomationDirect, nous nous efforçons constamment d’améliorer nos produits et services. 
C’est pourquoi nous nous réservons le droit d’apporter des modifications aux produits ou aux 
publications en tout temps, sans préavis ni quelque obligation que ce soit. La présente publication 
peut aussi porter sur des caractéristiques susceptibles de ne pas être offertes dans certaines versions 
révisées du produit.

Marques de commerce
La présente publication peut contenir des références à des produits fabriqués ou offerts par d’autres entreprises. Les désignations des 
produits et des entreprises peuvent être des marques de commerce et appartiennent exclusivement à leurs propriétaires respectifs. 
AutomationDirect nie tout intérêt dans les autres marques et désignations.

Copyright© 2024, Automationdirect.com® Incorporated
Tous droits réservés

Nulle partie de ce manuel ne doit être copiée, reproduite ou transmise de quelque façon que ce soit sans le consentement préalable 
écrit de la société Automationdirect.com® Incorporated. AutomationDirect conserve les droits exclusifs à l’égard de tous les 
renseignements contenus dans le présent document.
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Introduction 
Intended Use of This Product 

The PIAM-100 is a small computer with on-board I/O based on the “Open-Source Arduino 
platform”. This product can be used to solve various control and automation tasks using 
customized programs.
The user community website of PIAM-100 (http://go2adc.com/p1am) is where you 
will find various demo programs and libraries that will allow you to jump right into 
programming and design.
Follow all applicable safety parameters when connecting to external I/O sensors and 
devices.
Any use other: than described in this manual is not permitted, as this may expose the user 
to possible harm and/or damage to the device or connected equipment. 
The P1AM-100 must not be altered or modified. The safety instructions as well as the 
maximum permissible ambient conditions and operating parameters are given in Chapter 
2 “Technical Specifications”.  
The instruction manual is meant to be read thoroughly while being mindful of safe and 
proper operation. It contains important information on mounting, operating and handling 
the P1AM-100. 

CAUTION: The P1AM CPU Base Controller uses pins A3 and A4 so any shield that 
uses these same pins will have a conflict.  The MKR RGB shield is one that has this 
conflict.

https://cdn.automationdirect.com/static/manuals/p1amuserm/p1amuserm.html
http://go2adc.com/p1am
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Purpose of this Manual  
Thank you for purchasing the AutomationDirect ProductivityOpen Arduino compatible 
Controller.  This user manual provides information that will help you install, set up, program, 
troubleshoot, and maintain your ProductivityOpen project.  
The manual includes information that is critical to the safety of the personnel who will install 
and use the controller and to the machinery, processes, and equipment controlled by the 
P1AM-100.
The manual also includes important information about power and signal wiring, mounting 
the CPU and modules, and configuring the system.

Important Online Resources
Access to ADC Community based help for your ProductivityOpen projects is available from 
our website: http://go2adc.com/p1am.
You will need libraries and other files available from our GitHub page at  
https://github.com/facts-engineering/P1AM

The P1AM libraries and Board Support Package and other support files are located on 
Github.
A variety of other useful information about the Productivity1000 I/O modules, as well as 
code for example tasks and more is available at https://facts-engineering.github.io.

The P1AM-100 may be programmed by Arduino IDE which may be downloaded from  
https://www.arduino.cc/en/Main/Software.  A graphical programming tool customized for 
P1AM-100 based on ArduBlock (ProductivityBlocks® )is accessible from the Tools menu in 
the Arduino IDE. 

In addition, the Productivity1000 series power supplies and I/O modules, which work with 
the P1AM-100, include an installation insert.

Use a QR symbol reader or click on graphic icon to see an overview video. 

https://cdn.automationdirect.com/static/manuals/p1amuserm/p1amuserm.html
http://go2adc.com/p1am
https://github.com/facts-engineering/P1AM
http://facts-engineering.github.io
https://www.arduino.cc/en/Main/Software
https://www.automationdirect.com/VID-PA-0001
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Conventions Used

NOTE: When you see the “note pad” icon in the left-hand margin, the paragraph to its immediate 
right will be a special note.  Notes represent information that may make your work quicker or 
more efficient.  The word NOTE in boldface will mark the beginning of the text.

WARNING: When you see the “exclamation point” icon in the left-hand margin, the 
paragraph to its immediate right will be a warning.  This information could prevent 
injury, loss of property, or even death in extreme cases.  Any warning in this manual 
should be regarded as critical information that should be read in its entirety. The 
word WARNING in boldface will mark the beginning of the text.

Key Topics for Each Chapter
The beginning of each chapter will list 
the key topics that can be found in that 
chapter.

https://cdn.automationdirect.com/static/manuals/p1amuserm/p1amuserm.html
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Install Programming Software

NOTE: An active Internet connection is required to download the Arduino IDE and access the 
libraries and board driver.

The P1AM-100 CPU may be programmed with the Arduino IDE. ProductivityBlocks® is an 
optional graphical environment used with the IDE that AutomationDirect has adapted to 
make Productivity1000 I/O modules conveniently accessible as blocks. 

1. Download the latest version of the Arduino IDE software 
from https://www.arduino.cc/en/Main/Software.

2. Library Install: 
a.	In the Arduino IDE go to “Sketch -> Include Library -> Manage Libraries…” 
b.	Leave the Type and Topic filters as “All” and type “P1AM” in the “Filter your 

search…” box
c.	Click on the P1AM by FACTS Engineering that appears
d.	Click the Install button
e.	Close the Library Manager window
f. Confirm the installation by checking for “File -> Examples -> P1AM-100”. Several 

categories of examples should be present.

CCCC
Blocks

Productivity

https://cdn.automationdirect.com/static/manuals/p1amuserm/p1amuserm.html
https://www.arduino.cc/en/Main/Software
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3. Arduino Board Support Package Install: 
a.  Go to “File->Preferences” and paste the following link into the “Additional Boards 

Manager URLs” field.

NOTE:  Make sure you right click on the link and choose “Copy Link”.

	 i.  https://raw.githubusercontent.com/facts-engineering/facts-engineering.github.
io/master/package_productivity-P1AM-boardmanagermodule_index.json

b.  Go to “Tools -> Boards -> Board Manager”.  Type P1AM into the search box at 
the top. Mouse over the result and click install.  The install may take several 
minutes to complete.
c.  If you are on a version of Windows before Windows 10 this is mandatory.  For 

Windows 10 users, this may be run if you want the board to appear as P1AM-
100 (or P1AM-200) in device manager. 

		  i.	 Download the “driver install” file from this link:  
https://github.com/facts-engineering/P1AMCore/raw/master/drivers.zip.

		  ii.	Extract the file 
		  iii.	Run the “P1AM-100_install.bat” file to complete the driver installation.
d.	 If you are having trouble installing the BSP due to network issues such as 

firewall restrictions, you can use the “Arduino SAMD Boards” (specifically the 
MKRZERO) as an alternative. These are present in the board manager 
automatically.

4. Testing installation
a.	Attach the modules and/or shields you wish to use. REMEMBER modules/shields 

must not be connected or disconnected while power is applied - either 24V or 
USB.

b.	Plug the micro USB cable into the P1AM CPU and computer
		  i. If using P1000 I/O modules power the system with 24V

c.	Go to “Tools -> Board:” and select the “P1AM-100 or P1AM-200” from the 
dropdown that appears.

d.	Go to “Tools -> Port” and select the “P1AM CPU” device that you have plugged in.
e.	Go to File -> Examples -> P1AM-100 (or P1AM-200) ->Basic->PrintModules to 

open the Print Modules example. Note that the  PrintModules example is intended 
for a system with Productivity1000 modules connected and powered.

f.	 Click the right facing arrow button under “Edit” to upload the code to the board.
g.	Go to “Tools -> Serial Monitor” and check to see that the name of module(s) you 

have in the base is printing to the terminal.

https://cdn.automationdirect.com/static/manuals/p1amuserm/p1amuserm.html
https://raw.githubusercontent.com/facts-engineering/facts-engineering.github.io/master/package_productivity-P1AM-boardmanagermodule_index.json
https://raw.githubusercontent.com/facts-engineering/facts-engineering.github.io/master/package_productivity-P1AM-boardmanagermodule_index.json
https://github.com/facts-engineering/P1AMCore/raw/master/drivers.zip
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5.	 Next Steps
a.	Start with the “Basic” category of the P1AM CPU Library examples to become 

familiar with the API. 
b.	Once you are comfortable with the basic examples you can move on to more 

complex routines included in the P1AM CPU examples.
6.	 Install ProductivityBlocks®

a.	Run the ProductivityBlocks Installer.
b.	ProductivityBlocks will be installed in the Documents -> ProductivityBlocks folder. 

The ProductivityBlocks programming environment is accessible from the Tools 
menu in the Arduino IDE.

c.	Example ProductivityBlocks programs are also included in this folder.

Blocks
Productivity

https://cdn.automationdirect.com/static/manuals/p1amuserm/p1amuserm.html


Chapter 1: Getting Started

1–8 Hardware User Manual, 1st Ed. Rev. F

Step One: With latch 
in “locked” position, align 
connectors on the side of 
each module and stack 
by pressing together.  An 
audible click indicates lock is 
engaged.

Step Two: Attach field wiring 
using the removable terminal 
block or ZIPLink wiring system. 

CAUTION!  Ensure all 
latches are secured after 
modules are connected.

Step Three: To unstack 
modules, pull locking latch up into 
the unlocked position and then 
pull modules apart.

Mounting Hardware
Install Shields on the left side of the P1AM CPU and P1 I/O Modules on the right side 
of the P1AM CPU.
The ProductivityOpen Shields and Productivity1000 Input/Output modules are DIN 
rail mountable and designed to snap together to simplify connection.  A system 
may include communications, inputs and outputs. See Chapter 3 of this manual 
and Chapters 4 and 5 of the Productivity1000 manual for more detailed hardware 
installation information.  

WARNING!  Do not add or remove modules with field power applied!

https://cdn.automationdirect.com/static/manuals/p1amuserm/p1amuserm.html
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Power the System
NOTE: Ensure all modules are connected to the system before power is applied. Do not assemble 
or disassemble the system while power is applied. 

Productivity1000 Power Supplies:
1.	 Connect one of the Productivity1000 power supplies to P1AM CPU.  Should 

you choose Arduino MKR compatible shields instead of or in addition 
to the ProductivityOpen shields, the Productivity1000 power supplies 
cannot be used. In this case an alternative power supply is required (See 
below for information on connecting an external power supply).

P1000 AC input power supplies: 
•	 P1-01AC: AC Input 85–132 / 170–264 VAC, 16W  

(power for P1AM-100 and up to 8 modules)
•	 P1-02AC: AC Input 85–132 / 170–264 VAC, 26W  

(power for P1AM-100 and up to 15 modules)
P1000 DC input power supplies: 

•	 P1-01DC: DC Input 12–24 VDC, 16W  
(power for P1AM-100 and up to 8 modules)

CAUTION: Ensure that only one power supply source is connected to the Arduino 
system.  When a Productivity1000 power supply is connected immediately to the left 
of the CPU module, the bottom Power Connector must be removed before connecting 
P1-01AC Power Supply.  This precludes connection of two separate power supplies. If 
an AutomationDirect shield is connected between a Productivity1000 power supply 
and the CPU module care must be taken to ensure an external power supply is not 
connected to the bottom terminals. 

P1-01DCP1-01AC P1-02AC

P1-01DC

+V

-V

G

LG

12-24V     21W

™

P1-02AC

AC (L)

AC (N)

G

LG

100-240V      74VA
50-60Hz

125VDC, 33W

DC (+V)

DC (-V)

™

P1-01AC

AC (L)

AC (N)

G

LG

100-240V      48VA
50-60Hz

125VDC, 20W

DC (+V)

DC (-V)

®
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Terminal Block Specifications
Part Number PCON-KIT
Number of positions 3 screw terminals
Pitch 3.5 mm

Wire Range 28–16 AWG (0.324 to 3.31 mm²) Solid / Stranded conductor 
1/4 in (6–7 mm) Strip Length

Conductors Use copper conductors, 75°C or equivalent
Screw Driver Width 1/8 in (3.175 mm) Maximum
Screw Size M2
Screw Torque 1.7 lb·in (0.4 N·m)

*Recommended screw driver P/N:  TW-SD-MSL-2

2. OR using an alternative 24VDC external power source connect directly 
to P1AM CPU Optional Power Connector terminals. This option allows 
for the use of Input/Output modules from the Productivity1000 
family as well as all Arduino MKR compatible shields. 

•	 The LG and minus terminals on the external power supply connection are 
internally shorted.

•	 Use separate 24VDC supplies, one for the P1AM CPU and another for inductive 
loads to keep the P1AM CPU supply power clean and free of voltage spikes 
caused by switching inductive loads.

Example of Alternative  
24VDC Power Supply

RHINO Power Supply 
P/N PSV24-50s

https://cdn.automationdirect.com/static/manuals/p1amuserm/p1amuserm.html
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3. OR using USB input power, connect to the microB USB port on the 
face of the P1AM CPU.  USB power is intended for programming 
and will not power Productivity1000 Input /output modules.

Micro USB Type B Input Specifications
Port Name Micro USB
Description Standard Micro USB input for programming and monitoring
Port Status LED Green LED is illuminated when a power cable is plugged in. 

Cables
USB Type A to Micro USB Type B:  
    6ft cable part # USB-CBL-AMICB6 
   15ft cable part # USB-CBL-AMICB15

https://cdn.automationdirect.com/static/manuals/p1amuserm/p1amuserm.html
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Overview 
The ProductivityOpen system is intended to provide a robust selection of components for a 
compact and expandable design with a simple-to-use philosophy. 

Right Side Expansion - Productivity1000 Input/output Modules
The P1AM-100 can be expanded with the addition of easily connected I/O modules and 
does not require a mounting base.  I/O modules are connected via an expansion port 
on the right side of the P1AM-100 case. A variety of I/O modules are available from 
the Productivity1000 series for flexible and optimal system configuration. Refer to the 
Productivity1000 user manual for detailed descriptions (https://cdn.automationdirect.com/
static/manuals/p1userm/p1userm.html).  

Left Side Expansion - Arduino MKR-compatible Shields 
The left side of the case allows expansion with most* Arduino MKR compatible shields.  A 
selection of shields to support P1AM-100 in housings to conveniently connect to the  
P1AM-100 specifically are available from AutomationDirect. See detailed descriptions 
following.

* NOTE:  The P1AM CPU Base Controller uses pins A3 and A4 so any shield that uses these same 
pins will have a conflict. The MKR RGB shield is one that has this conflict.

https://cdn.automationdirect.com/static/manuals/p1amuserm/p1amuserm.html
https://cdn.automationdirect.com/static/manuals/p1userm/p1userm.html
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General Specifications
Operating Temperature 0° to 60°C (32° to 140°F)
Storage Temperature -20° to 70°C (-4° to 158°F)
Humidity 5 to 95% (non-condensing)
Altitude 2,000 meters, max.
Pollution Degree 2
Environmental Air No corrosive gases permitted
Vibration IEC60068-2-6 (Test Fc)
Shock IEC60068-2-27 (Test Ea)
Heat Dissipation 4000mW
Overvoltage Category II
Enclosure Type Open Equipment

Module Location
Productivity1000 I/O modules connect on the right 
side of module. Productivity1000 power supply, P1AM 
Shields and MKR Shields connect on the left side on 
the module.

Weight 76g (2.8 oz)

Agency Approvals

UL 61010-1 and UL 61010-2-201 File E139594, 
Canada & USA
CE (EN 61131-2 EMC, EN 61010-1 and EN 61010-2-
201 Safety)

P1AM-100 Arduino Compatible CPU
The P1AM-100 is an Arduino-compatible CPU. It uses the Atmel SAMD21G18 micro-
controller and can be programmed using Arduino IDE or ProductivityBlocks®. It interfaces 
with all Productivity1000 Series I/O modules connected to the right side of the P1AM-100 
and most Arduino MKR form factor shields connected to the left side. The specifications 
are listed in the tables below.  

P1AM-100

ULC USR

User Specifications
User Memory 256kB Flash with 10kB used for bootloader

Memory Type Flash: 256kB, SRAM: 32kB

Base Controller and I/O 
Power Requirement1

24VDC ±2%
Plan 0.5 W for the SAMD chip and base controller 
Plan 1.25 W per P1000 I/O module
Plan 9W for max. header power draw (which provides 
max. 4.25 W power to left side connected shields).

Recommended Fuse 
(External)

Edison S5061-R, Time Delay, 1A Fuse
For 9–15 modules: Edison S5062-R, Time Delay, 2A 
Fuse

Peripherals MicroB USB, Arduino MKR-compatible, microSD card 
slot, User controlled LED

Hardware Limits of System2 15 Productivity1000 I/O Modules; Arduino MKR 
shields

Programming Programmed in C/C++ with the Arduino IDE or 
ProductivityBlocks®

¹ If you do not use a Productivity1000 power supply, like the P1-01AC, then use a power 
supply that has transformer isolation. Use different 24VDC supplies for the CPU and inductive 
loads to keep the CPU power clean and free of voltage spikes caused by switching solenoids, 
motors and relay coils.
² See MKR Expansion Bus table and notes for shield power budget restrictions.

Blocks
Productivity

https://cdn.automationdirect.com/static/manuals/p1amuserm/p1amuserm.html
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P1AM-100

Toggle Switch Specifications
Switch can be read using the “digitalRead” function. 
Switch can be referred to as “SWITCH_BUILTIN” or 
Pin 31.

CPU Status Indicators
PWR Green LED is illuminated when power is ON

BASE Green LED is illuminated when P1AM I/O 
controller is powered and has been initialized

LED
Yellow LED is illuminated when commanded 
by user program. LED can be referred to as 
LED_BUILTIN or Pin 32.

P1AM-100 Module Faceplate Layout

Reset Switch Specifications
	• Press once to manually reset code 
execution, the Base Controller, and all 
P1000 Series modules.

	• Press twice quickly to put the P1AM CPU 
into bootloader mode.

https://cdn.automationdirect.com/static/manuals/p1amuserm/p1amuserm.html
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P1AM-100

Micro USB Type B Specifications
Port Name MicroB USB

Description Standard MicroB USB input for programming, monitoring, 
and a power option

Port Status LED Green LED is illuminated when a power cable is plugged 
in. 

Cables
USB Type A to Micro USB Type B:  
    6ft cable part # USB-CBL-AMICB6 
   15ft cable part # USB-CBL-AMICB15

P1AM-100 MicroB USB Programming Port
The P1AM-100 controller has one built-in communication port; used exclusively for 
connecting to a PC running the Arduino IDE programming software. Following are the 
specifications and pin-out diagram.

https://cdn.automationdirect.com/static/manuals/p1amuserm/p1amuserm.html
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microSD Slot
Retentive memory for data logging, parameter storage, etc. (Card not included with unit). 

1

8

Pin SD
1
2
3
4
5
6
7
8

DAT2
CD/DAT3

CMD
VDD
CLK
VSS
DAT0
DAT1

microSD Specifications
Port Name microSD

Description Standard microSD socket for data logging
Maximum Card 
Capacity 32GB

Transfer Rate  
(ADATA microSDHC 
Class 4 memory card)

Mbps Minimum Typical Maximum

Read 14.3 14.4 14.6

Write 4.8 4.9 5.1

Port Status LED Green LED is illuminated when card is inserted and 
detected

Pin SD
1 DAT2
2 CD/

DAT3
3 CMD
4 VDD
5 CLK
6 VSS
7 DAT0
8 DAT1

https://cdn.automationdirect.com/static/manuals/p1amuserm/p1amuserm.html
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P1AM-100

CPU

Shield
CPU

P1AM-100 CPU Headers
Following are the specifications and pin-out diagram for the Arduino MKR-compatible 
expansion bus available for Left Side Expansion Arduino MKR-compatible shields.

MKR Expansion Bus Pins
GPIO A0–A6, 0–14
Analog Input Pins A0–A6
Analog Output 
Pins A0

PWM Pins 0–8, 10, A3, A4
Interrupt Pins 0, 1, 4–8, A1, A2
5V 5V supply output
Vin 5V regulated supply

VCC 3.3 V supply output

GND Ground

RST Reset

AREF Analog Input Reference
Critical Notes: 
Pins A3, A4, and 8–10 are used for the base 
controller. 
Do not exceed 46mA combined from pins 0, 1, and 
4–10.
Do not exceed 3.3 V on any I/O pin.
Do not exceed 7mA on any I/O pin.
Do not apply power to 5V or VCC

https://cdn.automationdirect.com/static/manuals/p1amuserm/p1amuserm.html
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P1AM-200 Arduino Compatible CPU
The P1AM-200 is an Arduino-compatible CPU. It uses the Atmel SAMD51P20 micro-
controller and can be programmed using Arduino IDE or in CircuitPython using any text 
editor. It interfaces with all Productivity1000 Series I/O modules connected to the right side 
of the P1AM-200 and most Arduino MKR form factor shields connected to the left side.  

P1AM-200

ULC USR

User Specifications
User Memory 1MB Internal flash with 16Kb used for bootloader.  

16MB External QSPI Flash; 2Kb EEPROM

Memory Type  Flash: 1MB; SRAM: 256Kb; 
 QSPI Flash: 16MB; EEPROM: 2Kb

Base Controller and I/O 
Power Requirement1

24VDC ±2%
Plan 0.5 W for the SAMD chip and base controller 
Plan 1.25 W per P1000 I/O module
Plan 9W for max. header power draw (which provides 
max. 4.25 W power to left side connected shields).

Recommended Fuse 
(External)

Edison S5061-R, Time Delay, 1A Fuse
For 9–15 modules: Edison S5062-R, Time Delay, 2A Fuse

Peripherals MicroB USB, Arduino MKR-compatible, microSD card slot, 
User controlled LED

Hardware Limits2 15 Productivity1000 I/O Modules; Arduino MKR shields

Programming Programmed in C/C++ with the Arduino IDE or 
CircuitPython in any text editor. 

¹ If you do not use a Productivity1000 power supply, like the P1-01AC, P1-02AC, or P1-01DC, then use 
a power supply that has transformer isolation. Use different 24VDC supplies for the CPU and inductive 
loads to keep the CPU power clean and free of voltage spikes caused by switching solenoids, motors 
and relay coils.
² See Header Power Limitations (page 2-13) in this chapter for additional resources.

General Specifications
Operating Temperature 0° to 60°C (32° to 140°F)
Storage Temperature -20° to 70°C (-4° to 158°F)
Humidity 5 to 95% (non-condensing)
Altitude 2,000 meters, max.
Pollution Degree 2
Environmental Air No corrosive gases permitted
Vibration IEC60068-2-6 (Test Fc)
Shock IEC60068-2-27 (Test Ea)
Heat Dissipation 4000mW
Overvoltage Category II
Enclosure Type Open Equipment

Module Location
Productivity1000 I/O modules connect on the right 
side of module. Productivity1000 power supply, P1AM 
Shields and MKR Shields connect on the left side on 
the module.

Weight 82g (2.89 oz)

Agency Approvals

UL 61010-1 and UL 61010-2-201 File E139594, 
Canada & USA
CE (EN 61131-2 EMC, EN 61010-1 and EN 61010-2-
201 Safety)
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P1AM-200

Toggle Switch Specifications
Switch can be read using the “digitalRead” function. 
Switch can be referred to as “SWITCH_BUILTIN”  
or Pin 31.

CPU Status Indicators
PWR Green LED is illuminated when power is ON

BASE Green LED is illuminated when P1AM I/O 
controller is powered and has been initialized

LED
Yellow LED is illuminated when commanded 
by user program. LED can be referred to as 
LED_BUILTIN or Pin 32.

P1AM-200 Module Faceplate Layout

Reset Switch Specifications
	• Press once to manually reset code 
execution, the Base Controller, and all 
P1000 Series modules.

	• Press twice quickly to put the P1AM CPU 
into bootloader mode.

https://cdn.automationdirect.com/static/manuals/p1amuserm/p1amuserm.html
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P1AM-200

Micro USB Type B Specifications
Port Name MicroB USB

Description Standard MicroB USB input for programming, monitoring, 
and a power option

Port Status LED Green LED is illuminated when a power cable is plugged 
in. 

Cables
USB Type A to Micro USB Type B:  
    6ft cable part # USB-CBL-AMICB6 
   15ft cable part # USB-CBL-AMICB15

P1AM-200 MicroB USB Programming Port
The P1AM-200 controller has one built-in communication port, used exclusively for 
programming.  It may be used with the Arduino IDE programming software or as a storage 
device to load Python files.  Following are the specifications and connector pinout diagram.

https://cdn.automationdirect.com/static/manuals/p1amuserm/p1amuserm.html
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microSD Slot
Retentive memory for data logging, parameter storage, etc. (Card not included with unit). 

1

8

Pin SD
1
2
3
4
5
6
7
8

DAT2
CD/DAT3

CMD
VDD
CLK
VSS
DAT0
DAT1

microSD Specifications
Port Name microSD

Description Standard microSD socket for data logging
Maximum Card 
Capacity 32GB

Transfer Rate  
(ADATA microSDHC 
Class 4 memory card)

Mbps Minimum Typical Maximum

Read 14.3 14.4 14.6

Write 4.8 4.9 5.1

Port Status LED Green LED is illuminated when card is inserted and 
detected

Pin SD
1 DAT2
2 CD/

DAT3
3 CMD
4 VDD
5 CLK
6 VSS
7 DAT0
8 DAT1
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P1AM-200

CPU

Shield
CPU

P1AM-200 CPU Headers
Following are the specifications and pin-out diagram for the Arduino MKR-compatible 
expansion bus available for Left Side Expansion Arduino MKR-compatible shields.

MKR Expansion Bus Pins
GPIO A0–A6, 0–14
Analog Input Pins A0–A6
Analog Output 
Pins A0

PWM Pins 0–8, 10, A3, A4
Interrupt Pins 0, 1, 4–8, A1, A2
5V 5V supply output
Vin 5V regulated supply

VCC 3.3 V supply output

GND Ground

RST Reset

AREF Analog Input Reference
Critical Notes: 
Pins A3, A4, and 8–10 are used for the base 
controller. 
Do not exceed 46mA combined from pins 0, 1, and 
4–10.
Do not exceed 3.3 V on any I/O pin.
Do not exceed 7mA on any I/O pin.
Do not apply power to 5V or VCC

WARNING: Use only a P1000 power supply 
OR an external 24V power supply, not both 
simultaneously.

https://cdn.automationdirect.com/static/manuals/p1amuserm/p1amuserm.html
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Powering Your ProductivityOpen System
It is important to understand that the Productivity1000 I/O modules on the right side will 
be powered either by the Productivity1000 power supply* connected to the left of the CPU 
OR by an external 24VDC power supply connected to the terminals at the bottom of the 
CPU module. The ProductivityOpen shields sold by AutomationDirect will also be powered 
by either of these sources. 

* NOTE: Connect only one of these 24VDC sources.

Third party shields on the left side shall be powered in the field according to the 
manufacturer specs.
The USB programming cable will power the CPU and shields connected on the left side of 
the CPU. 

CAUTION!  Shields and I/O modules must not be connected or disconnected when power is 
applied.

Power Supply Options
LSX Shields

CPU
RSX

Open ADC ADC 
I/O

USB Power Cable 
(5VDC) ø ø ø

ADC P1-01AC or 
P1-02AC ø ø ø

AUX 24Vin ø ø ø ø

MKR Header Power Limitations

Power Source 5V 3.3 V
Max. 
Combined 
Power

USB 330mA 500mA 1.65 W

VIN (Pin Header) 600mA 1A 3.3 W

P1000 Series Supply 
OR External 24V 850mA 1.28 A 4.25 W

https://cdn.automationdirect.com/static/manuals/p1amuserm/p1amuserm.html
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AutomationDirect Shields
Ethernet Communications Shield

The P1AM-ETH is a housed Arduino Compatible Ethernet Shield based on the Wiznet W5500 
Ethernet Controller. It interfaces to the left side of the P1AM-100 CPU and most Arduino 
MKR form factor shields. 

Ethernet Features
•	Supports Hardwired TCP Protocols: 

 TCP, UDP, ICMP, IPV4, ARP, IGMP, PPPOE
•	Supports 8 independent sockets simultaneously
•	Supports Power Down Mode
•	Supports Wake on LAN over UDP
•	Supports High Speed Serial Peripheral Interface  

(SPI MODE 0, 3)
•	Internal 32K bytes of Memory for TX/RX Buffers
•	10BaseT / 100BaseTX Ethernet PHY embedded
•	Supports Auto Negotiation (Full and Half Duplex,  

  10 and 100-based)
•	Does Not Support IP Fragmentation
•	3.3 V operation with 5V I/O signal tolerance
•	LED outputs (Full / Half duplex, Link, Speed, Active)

General Specifications
Operating Temperature 0° to 60°C (32° to 140°F)
Storage Temperature -20° to 70°C (-4° to 158°F)
Humidity 5 to 95% (non-condensing)
Altitude 2,000 meters, max.
Pollution Degree 2
Environmental Air No corrosive gases permitted
Vibration IEC60068-2-6 (Test Fc)
Shock IEC60068-2-27 (Test Ea)
Heat Dissipation 750mW
Overvoltage Category II
Enclosure Type Open Equipment
Power Budget 150mA/5V
Recommended Library Arduino Ethernet
Module Location Connects to the left side of the P1AM-100 CPU.
Weight 20g (0.8 oz.)

Agency Approvals
UL 61010-1 and  
UL 61010-2-201 File E139594, Canada & USA
CE

!WARNING! 
 Do not add or remove 

modules with field power 
applied!
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Header Pins Used for 
Ethernet Shield
Pins 
Used Function Notes

5 ETH 
SS

8 MOSI SPI pins are 
shared with other 
devices on SPI 
bus

9 SCK
10 MISO

CPU or
Shield

P1AM-ETH

AutomationDirect Shields, cont’d

MKR Expansion Bus Pins
GPIO A0–A6, 0–14
Analog Input Pins A0–A6
Analog Output 
Pins A0

PWM Pins 0–8, 10, A3, A4
Interrupt Pins 0, 1, 4–8, A1, A2
5V 5V supply output
Vin 5V regulated supply

VCC 3.3 V supply output

GND Ground

RST Reset

AREF Analog Input Reference
Critical Notes: 
Pins A3, A4, and 8–10 are used for the base controller. 
Do not exceed 46mA combined from pins 0, 1, and 4–10.
Do not exceed 3.3 V on any I/O pin.
Do not exceed 7mA on any I/O pin.
Do not apply power to 5V or VCC

https://cdn.automationdirect.com/static/manuals/p1amuserm/p1amuserm.html
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Header Pins Used for Serial Shield
Pins 
Used Function Description

3 P1 Mode Port 1 Mode (Low=RS485 High=RS232)
14 P1 TX – Port 1 Data –
13 P1 RX + Port 1 Data +
A6 P1 DE/RE Port 1 Driver Enable / Receiver Enable
2 P2 Mode Port 2 Mode (Low=RS485, High=RS232)
0 P2 TX – Port 2 Data –
1 P2 RX + Port 2 Data +
6 P2 DE/RE Port 2 Driver Enable / Receiver Enable

Serial Communications Shield
The P1AM-SERIAL is a housed Arduino MKR Compatible Shield. It interfaces to the left side 
of the P1AM-100 CPU and most Arduino MKR form factor shields. 

Serial Features
•	2 RS-232/RS-485 (4-pin terminal) ports.
•	Supports RS-232 and RS-485 connections to serial devices 

using ASCII or custom communication protocols
•	LED outputs (RS-232/RS-485 mode selection, TX and RX 

activity)

General Specifications
Operating Temperature 0° to 60°C (32° to 140°F)
Storage Temperature -20° to 70°C (-4° to 158°F)
Humidity 5 to 95% (non-condensing)
Altitude 2000 meters max.
Pollution Degree 2
Environmental Air No corrosive gases permitted
Vibration IEC60068-2-6 (Test Fc)
Shock IEC60068-2-27 (Test Ea)
Overvoltage Category II
Voltage Withstand (dielectric) Non-Isolated
Insulation Resistance Non-Isolated
Heat Dissipation 380mW
Enclosure Type Open Equipment
Power Budget 115mA/3.3 V
Recommended Library P1AM_Serial

Module Location Shield connects to the left side of the P1AM CPU. 
P1-01AC/02AC can connect to the left side of the Sheild.

Weight 77g (2.7 oz.)

Agency Approvals
UL 61010-1 and  
UL 61010-2-201 File E139594, Canada & USA
CE

!WARNING! 
 Do not add or remove 

modules with field power 
applied!

Note: If a P1AM-GPIO module is installed alongside a P1AM-SERIAL 
module, the above pins will be unavailable to the P1AM-GPIO.
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Header Pin Breakout Module
The P1AM-GPIO is a housed Arduino MKR form factor shield that brings a subset of the 
MKR header pins out to the front 18 position terminal block. These pins include basic 
overvoltage, undervoltage, and overcurrent protection. It connects to the left side of the 
P1AM-100 CPU and most Arduino MKR form factor shields.

General Specifications
Operating Temperature 0° to 60°C (32° to 140°F)
Storage Temperature -20° to 70°C (-4° to 158°F)
Humidity 5 to 95% (non-condensing)
Altitude 2,000 meters, max.
Pollution Degree 2
Overvoltage Category II
Environmental Air No corrosive gases permitted
Vibration IEC60068-2-6 (Test Fc)
Shock IEC60068-2-27 (Test Ea)
Heat Dissipation 475mW
Enclosure Type Open Equipment
Module Location Connects to the left side of the P1AM-100 CPU.
Weight 56g (2.0 oz.)

Agency Approvals
UL 61010-1 and  
UL 61010-2-201 File E139594,  
Canada & USA CE

Terminal block connector sold 
separately. Recommended connector 

options P2-RTB or P2-RTB-1.

!WARNING!   
Do not add or remove 

modules with field power 
applied!
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Shield
CPU or

P1AM-GPIO

AutomationDirect Shields, cont’d

MKR Expansion Bus Pins
GPIO A0–A6, 0–14
Analog Input Pins A0–A6
Analog Output 
Pins A0

PWM Pins 0–8, 10, A3, A4
Interrupt Pins 0, 1, 4–8, A1, A2
5V 5V supply output
Vin 5V regulated supply

VCC 3.3 V supply output

GND Ground

RST Reset

AREF Analog Input Reference

Critical Notes: 
Pins A3, A4, and 8–10 are used for the base 
controller. 
Do not exceed 46mA combined from pins 0, 1, and 
4–10.
Do not exceed 3.3 V on any I/O pin.
Do not exceed 7mA on any I/O pin.
Do not apply power to 5V or VCC

*There is no ESD, overvoltage, or overcurrent 
protection on the DAC0 pin. 

Terminal Block Pins
Pin Functions

VCC 3.3 V supply output

DAC0* GPIO, Analog input,  
Analog output

A1 GPIO, Analog input, 
Interrupt

A2 GPIO, Analog input, 
Interrupt

A5 GPIO, Analog input
A6 GPIO, Analog input

0 GPIO, PWM, Interrupt

1 GPIO, PWM, Interrupt

2 GPIO, PWM

3 GPIO, PWM

4 GPIO, PWM, Interrupt

6 GPIO, PWM, Interrupt

7 GPIO, PWM, Interrupt

11 GPIO, SDA

12 GPIO, SCL

13 GPIO, RX

14 GPIO, TX

GND Ground
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Productivity1000 Modules
Discrete Input Modules

Part Number Inputs Description

P1-08SIM 8 Input Simulator Module

P1-08ND3 8 Sinking/Sourcing  
12–24 VDC Input

P1-08ND-TTL 8 Sinking/Sourcing  
3.3–5 VDC Input

P1-16ND3 16 Sinking/Sourcing  
12–24 VDC Input

P1-08NE3 8 Sinking/Sourcing  
24V AC/DC

P1-16NE3 16 Sinking/Sourcing  
24V AC/DC

P1-08NA 8 AC Isolated  
100–240 VAC

Discrete Output Modules

Part Number Outputs Description

P1-08TD1 8 Sinking DC Output

P1-08TD2 8 Sourcing DC Output

P1-08TD-TTL 8 Sourcing DC Output

P1-15TD1 15 Sinking DC Output

P1-15TD2 15 Sourcing DC Output

P1-08TA 8 AC Output

P1-08TRS 8 Isolated Relay Output

P1-16TR 16 Relay Output

Discrete Input/Output Modules

Part Number Inputs/
Outputs Description

P1-15CDD1 8 7 Input: Sinking/Sourcing; 
Output: Sinking

P1-15CDD2 8 7 Input: Sinking/Sourcing; 
Output: Sourcing

P1-16CDR 8 8 Input: Sinking/Sourcing; 
Output: Relay

Productivity I/O Modules Overview
A variety of discrete and analog I/O modules from our Productivity1000 line are available 
for use with the P1AM-100 and P1AM-200. 

Details on connecting to the Productivity1000 modules can be found at  
https://github.com/facts-engineering/P1AM/wiki.
The Productivity1000 User Manual contains electrical and installation details. It is available 
for FREE download at: https://cdn.automationdirect.com/static/manuals/p1userm/p1userm.
html 

Productivity1000 Modules
Analog Input Modules

Part Number Inputs Description

P1-04AD 4 Analog Input (Current)

P1-04AD-1 4 Analog Input (Current)

P1-04AD-2 4 Analog Input (Voltage)

P1-04ADL-1 4 Analog Input (Current)

P1-04ADL-2 4 Analog Input (Voltage)

P1-08ADL-1 8 Analog Input (Current)

P1-08ADL-2 8 Analog Input (Voltage)

P1-04RTD 4 RTD Input

P1-04THM 4 Analog Thermocouple 
Input

P1-04NTC 4 Analog Thermistor Input

Analog Output Modules

Part Number Outputs Description

P1-04DAL-1 4 Analog Output (Current)

P1-04DAL-2 4 Analog Output (Voltage)

P1-08DAL-1 8 Analog Output (Current)

P1-08DAL-2 8 Analog Output (Voltage)

Analog Input/Output Modules

Part Number Inputs/
Outputs Description

P1-4ADL2DAL-1 4 2 Analog Input/Analog 
Output (Current)

P1-4ADL2DAL-2 4 2 Analog Input/Analog 
Output (Voltage)

https://cdn.automationdirect.com/static/manuals/p1amuserm/p1amuserm.html
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Safety Guidelines
NOTE: Products with CE marks perform their required functions safely and adhere to relevant 
standards as specified by CE directives provided they are used according to their intended 
purpose and that the instructions in this manual are adhered to.  The protection provided by the 
equipment may be impaired if this equipment is used in a manner not specified in this manual.  A 
listing of our international affiliates is available on our Web site at http://www.automationdirect.
com.

WARNING: Providing a safe operating environment for personnel and equipment 
is your responsibility and should be your primary goal during system planning and 
installation.  Automation systems can fail and may result in situations that can cause 
serious injury to personnel or damage to equipment.  Do not rely on the automation 
system alone to provide a safe operating environment.  You should use external 
electromechanical devices, such as relays or limit switches, that are independent of 
the P1AM-100 application to provide protection for any part of the system that may 
cause personal injury or damage.  Every automation application is different, so there 
may be special requirements for your particular application.  Make sure you follow 
all national, state, and local government requirements for the proper installation 
and use of your equipment.

Plan for Safety
The best way to provide a safe operating environment is to make personnel and 
equipment safety part of the planning process.  You should examine every aspect of the 
system to determine which areas are critical to operator or machine safety.  If you are not 
familiar with controller type system installation practices, or your company does not have 
established installation guidelines, you should obtain additional information from the 
following sources.

•	 NEMA — The National Electrical Manufacturers Association, located in 
Washington, D.C., publishes many different documents that discuss standards 
for industrial control systems.  You can order these publications directly from 
NEMA. Some of these include:  
	 ICS 1, General Standards for Industrial Control and Systems  
	 ICS 3, Industrial Systems  
	 ICS 6, Enclosures for Industrial Control Systems

•	 NEC — The National Electrical Code provides regulations concerning the 
installation and use of various types of electrical equipment.  Copies of the 
NEC Handbook can often be obtained from your local electrical equipment 
distributor or your local library.

•	 Local and State Agencies — many local governments and state governments 
have additional requirements above and beyond those described in the NEC 
Handbook.  Check with your local Electrical Inspector or Fire Marshall office for 
information.
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Three Levels of Protection

WARNING: The control program must not be the only 
form of protection for any problems that may result in 
a risk of personal injury or equipment damage.

The publications mentioned provide many ideas and 
requirements for system safety.  At a minimum, you 
should follow these regulations.  Also, you should use 
the following techniques, which provide three levels of 
system control.

1.	 Orderly system shutdown sequence in 
the P1AM-100 control program.

2.	 Mechanical disconnect for output module power.
3.	 Emergency stop 

switch for disconnecting system power.
4.	 Orderly System Shutdown

The first level of fault detection is ideally the P1AM-100 control program, which can identify 
machine problems.  Certain shutdown sequences should be performed.  These types of 
problems are usually things such as jammed parts, etc., that do not pose a risk of personal 
injury or equipment damage.

System Power Disconnect
You should also use electromechanical devices, such as master control relays and/or limit 
switches, to prevent accidental equipment startup at an unexpected time.  These devices 
should be installed in a manner that will prevent any machine operations from occurring. 
For example, if the machine in the illustration has a jammed part, the P1AM-100 control 
program can turn off the saw blade and retract the arbor.  If the operator must open the 
guard to remove the part, you should also include a bypass switch that disconnects all 
system power any time the guard is opened.

Jam
Detect

RST

Retract
  Arm

Turn off
   Saw

RST
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Emergency Stop Circuits
Emergency stop (E-Stop) circuits are a critical part of automation safety.  For each machine 
controlled by a P1AM-100, provide an emergency stop device that is wired outside the 
P1AM-100 and easily accessed by the machine operator. 
E-Stop devices are commonly wired through a master control relay (MCR) or a safety 
control relay (SCR) that will remove power from the P1AM-100 I/O system in an 
emergency.
MCRs and SCRs provide a convenient means for removing power from the I/O system 
during an emergency situation.  By de-energizing an MCR (or SCR) coil, power to the 
input (optional) and output devices is removed.  This event occurs when any emergency 
stop switch opens.  However, the P1AM-100 continues to receive power and operate even 
though all its inputs and outputs are disabled.
The MCR circuit could be extended by placing a P1AM-100 fault relay (closed during 
normal P1AM-100 operation) in series with any other emergency stop conditions.  This 
would cause the MCR circuit to drop the P1AM-100 I/O power in case of a P1AM-100 
failure (memory error, I/O communications error, etc.).

WARNING: For some applications, field device power may still be present on the 
terminal block even though the P1AM-100 is turned off.  To minimize the risk of 
electrical shock, remove all field device power before you expose or remove P1AM-
100 wiring.

Saw Arbor

E-Stop Power On

Use E-Stop and Master Control Relay
   

Limit
Switch

Master
Control

Relay (MCR)

L1 N

MCR

MCR CR1

MCR CR1

SE-Stop Power On

Use E-Stop and Maste
   

S

L1

MCR

MCR

EMERGEN
CY

STOP

Guard
Limit
Switch
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Introduction to the ProductivityOpen Mechanical 
Design

The ProductivityOpen is a modular system that can be created by adding Productivity1000 
input/output modules and Arduino MKR-compatible shields to a P1AM-100 Arduino-
compatible CPU.  The I/O  modules are connected directly to the right side of the P1AM-
100 and to each other in a continuous stack up to 15 modules.
Power budget does need to be considered - 8 or fewer modules can use the P1-01AC; 
exceeding 8 modules uses P1-02AC.  No backplane or base is required.  Each module 
connection extends the integrated communication bus. 
Connect Arduino-MKR shields to the left side of the P1AM-100 CPU. The combinations on 
the left side are limited only by the general purpose I/O pins that must be dedicated to 
each shield.

Typical P1AM-100

P1AM-PROTO 
(Customizable  
Shield Kit)

P1AM-SERIAL
P1-01AC 
Power Supply 
or Alternate

P1AM-ETH

P1AM-GPIO

P1-08TD1 
Output ModuleP1-15CDD1 

Combo Module

P1-15CDD1

C1
1
2
3
4
5
6
7
8

1
2
3
4
5
6
7

V+

C2
IN

PU
TS

OU
TP

UT
S

12-24VDC IN
3.3-24V OUT

V+

2
3
4

COM
5
6
7
8

1

P1-08TD1

3.3-24VDC
SINK OUTPUT

1

8

7

6

5

4

3

2

OFF ON

INPUT SIMULATOR

P1-08SIM

P1AM-100

P1-08SIM  
Input Module
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Dimensions and Installation
Before installing the P1AM-100 you will need to know the dimensions of the components 
considered.  The tables and diagrams on the following pages provide basic dimensions 
to use in defining your enclosure specifications.  Remember to leave room for expansion 
module insertion and/or replacement and for potential expansion.  If you are using other 
components in your system, refer to the appropriate manual to determine how those units 
can affect mounting dimensions.
The basic dimensions for the modules are listed in the tables.  The width varies depending on the 
type of module.  P1AM-100 is designed to be mounted on standard 35mm DIN rail, or it may be 
surface mounted.  Make sure you have followed the installation guidelines for proper spacing.

NOTE: Dimensional drawings for the P1AM-100, power supplies, and all modules are available on 
the AutomationDirect.com site.

Productivity1000 Component Dimensions
P1-01AC AC/DC Power Supply 35.0 

[1.38]

77.0 
[3.03]

92.8 
[3.65]

98.3 
[3.87]

P1-02AC AC/DC Power Supply 52.2 
[2.06]

P1-01DC DC Power Supply 35.0 
[1.38]

P1-02DC DC Power Supply 35.0 
[1.38]

Discrete Expansion Modules (Right Side)

P1-08SIM Simulator Input

17.2 
[0.68]

77.0 
[3.03]

93.6 
[3.69]

86.6 
[3.41]

P1-08ND-TTL Sinking/Sourcing 12–24 VDC Input 81.6 
[3.21]

P1-08ND3 Sinking/Sourcing 12–24 VDC Input

86.6 
[3.41]

P1-16ND3 Sinking/Sourcing 12–24 VDC Input
P1-08NE3 Sinking/Sourcing 12–24 VAC/VDC Input

P1-16NE3 Sinking/Sourcing 12–24 VAC/VDC Input
P1-08NA AC Isolated 100–240 VAC
P1-08TD1 Sinking Output
P1-08TD2 Sourcing Output

P1-08TD-TTL Sinking/Sourcing Output 81.6 
[3.21]

P1-15TD1 Sinking Output 86.6 
[3.41]P1-15TD2 Sourcing Output

Productivity Open Component Dimensions

Module Description

A B C D

Width mm [in]
Height 
Faceplate 
mm [in]

Height  
w/Tabs 
mm [in]

Depth  
mm [in]

P1AM-100 Controller 23.1 [0.91] 77.0 [3.03] 92.8 [3.65] 91.3 [3.59]
P1AM-200 Controller 23.1 [0.91] 77.0 [3.03] 92.8 [3.65] 91.3 [3.59]
Left Side Communication Shields (LSX)

P1AM-GPIO General Purpose I/O 23.1 [0.91] 77.0 [3.03] 92.8 [3.65] 86.7 [3.41]
P1AM-ETH Ethernet Communication 23.1 [0.91] 77.0 [3.03] 92.8 [3.65] 89.7 [3.53]
P1AM-SERIAL Serial Communication 23.2 [0.91] 77.0 [3.03] 92.8 [3.65] 100.6 [3.96]
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ProductivityOpen Component Dimensions

Module Description

A B C D

Width mm 
[in]

Height 
Faceplate 
mm [in]

Height  
w/Tabs 
mm [in]

Depth  
mm [in]

P1-08TA AC Output 17.2 
[0.68]

77.0 
[3.03]

93.6 
[3.69]

86.6 
[3.41]

P1-08TRS Isolated Relay Output 17.2 
[0.68]

P1-16TR Relay Output 26.3 
[1.03]

P1-15CDD1 Input: Sinking/Sourcing;  
Output: Sinking 17.2 

[0.68]P1-15CDD2 Input: Sinking/Sourcing;  
Output: Sourcing

P1-16CDR Input: Sinking/Sourcing;
Output: Relay

26.3 
[1.03]

Analog Expansion Modules

P1-04RTD RTD Input

17.2 
[0.68]

77.0 
[3.03]

93.6 
[3.69]

81.6 
[3.21]

P1-04THM Thermocouple Input

P1-04NTC Thermistor Input

P1-04AD Analog Input (Current/Voltage)

P1-04AD-1 Analog Input (Current)

P1-04AD-2 Analog Input (Voltage)

P1-04ADL-1 Analog Input (Current)

17.2 
[0.68]

77.0 
[3.03]

93.6 
[3.69]

81.9 
[3.22]

P1-04ADL-2 Analog Input (Voltage)

P1-04DAL-1 Analog Output (Current)

P1-04DAL-2 Analog Output (Voltage)

P1-08ADL-1 Analog Input (Current)

17.2 
[0.68]

77.0 
[3.03]

93.6 
[3.69]

81.6 
[3.21]

P1-08ADL-2 Analog Input (Voltage)

P1-08DAL-1 Analog Output (Current)

P1-08DAL-2 Analog Output (Voltage)

P1-4ADL2DAL-1 Analog Input/Analog Output 
(Current)

P1-4ADL2DAL-2 Analog Input/Analog Output 
(Voltage)

Specialty Expansion Modules

P1-02HSC High-Speed Input (Current)
17.2 
[0.68]

77.0 
[3.03]

93.6 
[3.69]

81.6 
[3.21]P1-04PWM Pulse Width Modulation Input 

(Voltage)

Dimensions and Installation (continued)
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Basic Dimensions
Units: mm [inches]

P1AM-100

P1-01AC, P1-02AC, and P1-01DC

A

BC

D

C B

A

D
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Productivity1000 I/O Modules

Basic Dimensions (continued)

A D

C B

P1AM-GPIO Module

Units: mm [inches]

C B

A D
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Units: mm [inches]

P1AM-ETH

P1AM-SERIAL

C

B

A D

Units: mm [inches]

D

C B

A
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Mounting Guidelines
Enclosures

Your selection of a proper enclosure is important to ensure safe and proper operation of 
your P1AM-100.  Applications for the P1AM-100 vary and may require additional hardware 
considerations.  The minimum considerations for enclosures include:

•	 Conformance to electrical standards
•	 Protection from the elements in an industrial environment
•	 Common ground reference
•	 Not exceeding the specified maximum 

ambient temperature
•	 Access to the equipment
•	 Security or restricted access
•	 �Sufficient space for proper installation 

and maintenance of the equipment

Mounting Position
Mount the P1AM-100 and expansion modules horizontally, as shown in the cabinet 
illustration on the following page, to provide proper ventilation.  Do not mount vertically, 
upside down, or on a flat horizontal surface.

Airflow

2ʺ

NOTE: Add 2ʺ to mounting
depth when using ZIPLink
cable.

Using Mounting Rails
The ProductivityOpen modules can be secured within an enclosure or cabinet using 
mounting rails.  Use rails that conform to DIN EN standard 50022.  We offer a complete 
line of DIN rail, DINnectors and DIN rail mounted components.  The rails are approximately 
35mm high, with a depth of 7.5 mm.  When mounting the module(s) on a DIN rail, consider 
using end brackets on each side of the base.  The end brackets keep the module(s) from 
sliding horizontally along the rail, thus minimizing the possibility of accidentally pulling the 
wiring loose.

DIN Rail
Dimensions

7.5 mm

35 mm

End Bracket  
(Part No. DN-EB35)

DIN Rail  
(Part No. DN-R35S1)
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Mounting Clearances
Provide a minimum clearance of 2 inches (50mm) on all sides of the assembled system.  
Allow extra clearance for door mounted operator panels, push buttons, lights and other 
items.  There should be a minimum of 3 inches (76mm) vertical clearance between the 
module(s) and any wire duct, and a minimum of 7.2 inches (183mm) vertical distance from 
chassis to chassis in a multiple unit installation.
The clearances required for P1AM-100 are represented in the graphic below of a similar PLC 
system when mounted in an enclosure. 

Temperature Considerations
The P1AM-100 enclosure should be installed in an environment which is within the 
specified equipment operating temperature.  If the environment temperature deviates 
above or below the specified operating temperature range, measures such as cooling or 
heating the enclosure should be taken to stay within the range specification.

Power Considerations
When the P1AM-100 is powered by a Productivity power supply (P1-01AC, P1-02AC or 
P1-01DC), EMF/RFI line filters are not required to meet the requirements of the CE EMC 
Directive.

2”
50mm
min

2”
50mm
min

7.2”
183mm

min
18

3”
76mm
min

3”
76mm
min

Ground Buss
Earthed Ground
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In addition to the panel layout guidelines, other specifications can affect the installation of 
a CPU system.  Always consider the following:

•	 Environmental Specifications
•	 Power Requirements
•	 Agency Approvals
•	 Enclosure Selection and Component Dimensions 

Grounding
A sound common ground reference (earth ground) is essential for proper operation of 
the P1AM-100.  One side of all control circuits and power circuits along with the ground 
lead, must be properly connected to earth ground (earthing) either by connecting to the 
incoming power system ground or through a ground rod installed in close proximity to the 
enclosure.  This must be a single-point ground (i.e. copper buss bar) for all devices in the 
enclosure that require an earth ground.

WARNING: Do not disconnect equipment unless power has been switched off.

Agency Approvals
Some applications require agency approvals for particular components.  The 
ProductivityOpen agency approvals are listed below:

•	 UL (Underwriters’ Laboratories, Inc.)
•	 CUL (Canadian Underwriters’ Laboratories, Inc.)
•	 CE (European Economic Union)

Ground Braid 
Copper Lugs

Panel or 
Single Point 
Ground

Star Washers Star Washers

Panel

Ground Buss 
Bar
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DIN Rail Mounting P1AM-100 System
If you examine the module(s), you’ll notice retaining clips.  To secure the module(s) to a DIN 
rail, place the module(s) onto the rail and gently push up on the retaining clips.  The spring 
loaded clips lock the module onto the rail.  To remove the module(s), pull down on the 
retaining clips, rotate upward and lift up the base, drawing it away from the rail.
This installation procedure applies to the P1AM-100, P1AM-SERIAL, P1AM-ETH, and P1AM-
GPIO shields, and the Productivity1000 power supplies. 
Step 1:  Rotate unit upwards as you engage 

rear DIN rail slot (image at right).  Once 
engaged, rotate unit downwards, firmly 
pressing into DIN rail.  A noticeable click 
affirms the unit is secure to DIN rail. 

Step 2:  Ensure all retaining clips are 
pushed up into DIN rail. 

Step 3:  Install end brackets on either side of unit to 
ensure unit will not slide along the DIN rail. 

Surface Mounting P1AM-100 System
The P1AM-100 system may be surface mounted as well.  Extend the lower tabs for ease of 
access.  Use mounting holes in upper and lower tabs to secure the unit to panel surface.  

Push up 
retaining clips

Use Extended 
Lower Tab Slot

Use Upper 
Tab Slot
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Connecting the I/O Modules

WARNING: Do not connect, disconnect modules or operate switches while circuit 
is live. P1AM-100 does not support Hot Swapping!

Step One: With latch in 
“locked” position, align connectors 
on the side of each module and 
stack by pressing together.  An 
audible click indicates lock is 
engaged.

Step Two: To unstack 
modules, pull locking latch up 
into the unlocked position and 
then pull modules apart.
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Wiring Guidelines
Power Supply Wiring

Connect the AC power source input wiring to the power supply as shown.  The power 
supply terminals can accept up to 14AWG solid or stranded wire.  Do not over tighten the 
terminal screws; the recommended torque is 7 to 9 inch-pounds (0.882 to 1.02 N·m).

WARNING: Once the power wiring is connected, secure the terminal block cover in 
the closed position. When the cover is open there is a risk of electrical shock if you 
accidentally touch the connection terminals or power wiring.

Grounding
A good common ground reference (earth ground) is essential for proper operation of the 
P1AM-100.  One side of all control circuits and power circuits along with the ground lead 
must be properly connected to earth ground by either installing a ground rod in close 
proximity to the enclosure or by connecting to the incoming power system ground.  There 
must be a single-point ground (i.e. copper bus bar) for all devices in the enclosure that 
require an earth ground.

P1-01AC and P1-02AC

P1-01DC

Power HookupPower Hookup

Grounding
A good common ground reference (earth ground) is essential for proper operation of 
the Productivity1000 system. One side of all control circuits, power circuits and the 
ground lead must be properly connected to earth ground by either installing a ground 
rod in close proximity to the enclosure or by connecting to the incoming power system 
ground. There must be a single-point ground (i.e. copper bus bar) for all devices in the 
enclosure that require an earth ground.

P1-01AC

AC (L)

AC (N)

G

LG

100-240V      48VA
50-60Hz

125VDC, 20W

DC (+V)

DC (-V)

®

+V

-V

GND

LOGIC
GND

AC (L)

AC (N)

GND

LOGIC
GND

125VDC 100–240 VAC

Power HookupPower Hookup

Grounding
A good common ground reference (earth ground) is essential for proper operation of 
the Productivity1000 system. One side of all control circuits, power circuits and the 
ground lead must be properly connected to earth ground by either installing a ground 
rod in close proximity to the enclosure or by connecting to the incoming power system 
ground. There must be a single-point ground (i.e. copper bus bar) for all devices in the 
enclosure that require an earth ground.

P1-01AC

AC (L)

AC (N)

G

LG

100-240V      48VA
50-60Hz

125VDC, 20W

DC (+V)

DC (-V)

®

+V

-V

GND

LOGIC
GND

AC (L)

AC (N)

GND

LOGIC
GND

125VDC 100–240 VAC12–24 VDC
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Fuse Protection
Some of the Input and Output I/O module circuits do not have internal fuses.  In order 
to protect your modules, we suggest you add external fuses to your I/O wiring.  A fast-
blow fuse with a lower current rating than the I/O bank’s common current rating can be 
wired to each common; or a fuse with a rating of slightly less than the maximum current 
per output point can be added to each output.  Refer to the I/O module specifications in 
Chapter 2 to find the maximum current per output point or per output common.  Adding 
the external fuse does not guarantee the prevention of CPU damage, but it will provide 
added protection.

Power Supply 
Fused Common

Fuse Block

Fuse 
Blocks

Fuse 
Blocks

ZIPLink Fuse 
Module
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I/O Module Wiring Options
There are two available methods for wiring most I/O modules: hand wiring to the optional 
removable I/O module terminal blocks or using the ZIPLink wiring system.

NOTE: Thermocouple, Thermistor, RTD, and HSC modules are not compatible with the ZIPLink 
system and are shipped with fixed terminal blocks included.

Hand Wiring System
Field wiring may be attached using the removable terminal block connector.  Use 
Wire Strip Length reference on the terminal block as a guide when preparing wire for 
termination.  For easier assembly, wire may be connected to terminal block prior to 
installing block into expansion module. 
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I/O Module Wiring Options (continued)
ZIPLink Wiring System

The ZIPLink wiring system is the recommended method, which allows quick and easy 
connection using cables that are prewired to the I/O module terminals at one end and plug 
into a ZIPLink connector module terminal block at the other end.  Use the tables on the 
following pages to specify your ZIPLink wiring system.

Terminal Block With Pigtail Cable
For most I/O modules you can also purchase ZIPLink pigtail cables.

ZIPLink Pigtail Cable

ZIPLink Pre-Wired Cables ZIPLink Module

ZIPLink Wiring 
System
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Input and Output Module ZIPLink Selections

Productivity1000 Input Module ZIPLink Selector
I/O Module ZIPLink

Input Module # of Terms Component Module Part No. Cable Part No.

P1-08ND3 10

Feedthrough ZL-RTB20 or 
ZL-RTB20-1

ZL-P1-CBL10*
P1-16ND3 18 ZL-P1-CBL18*
P1-08NE3 10 ZL-P1-CBL10*
P1-16NE3 18 ZL-P1-CBL18*
P1-08NA 10 ZL-P1-CBL10*

Productivity1000 Output Module ZIPLink Selector
I/O Module ZIPLink

Output 
Module # of Terms Component Module Part No. Cable Part No.

P1-08TD1
10

Feedthrough ZL-RTB20 or  
ZL-RTB20-1

ZL-P1-CBL10*
P1-08TD2

P1-15TD1 18 ZL-P1-CBL18*

P1-15TD2 18 ZL-P1-CBL18*

P1-08TA 10 ZL-P1-CBL10*

P1-08TRS 10 ZL-P1-CBL10*

P1-16TR 18 ZL-P1-CBL18*

Productivity1000 Combo Modules ZIPLink Selector
I/O Module ZIPLink

Output 
Module # of Terms Component Module Part No. Cable Part No.

P1-15CDD1

18 Feedthrough ZL-RTB20 or  
ZL-RTB20-1 ZL-P1-CBL18*P1-15CDD2

P1-16CDR

* �Select the cable length by replacing the * with: Blank = 0.5 m, -1 = 1.0 m, or -2 = 2.0 m.
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Analog Modules ZIPLink Selections

Productivity1000 Analog Module ZIPLink Selector
Module ZIPLink

Analog Module # of Terms Component Module Cable

P1-04AD 18 Feedthrough

ZL-RTB20 or 
ZL-RTB20-1

ZL-P1-CBL18*
P1-04AD-1

10 Feedthrough ZL-P1-CBL10*

P1-04AD-2

P1-04ADL-1

P1-04ADL-2

P1-08ADL-1

P1-08ADL-2

P1-04RTD Matched 
Only See Note 1

P1-04THM T/C Wire 
Only See Note 1

P1-04NTC Copper 
Conductors See Note 1

P1-04DAL-1

10 Feedthrough ZL-RTB20 or 
ZL-RTB20-1 ZL-P1-CBL10*

P1-04DAL-2

P1-08DAL-1

P1-08DAL-2

Productivity1000 Specialty Modules ZIPLink Selector
Module ZIPLink

Input Module # of Terms Component Module Cable

P1-08SIM See Note 1
P1-02HSC See Note 1

P1-04PWM 10 Feedthrough ZL-RTB20 or 
ZL-RTB20-1 ZL-P1-CBL10*

Productivity1000 Analog Combo Module ZIPLink Selector
Module ZIPLink

Analog Module # of Terms Component Module Cable

P1-4DAL2ADL-1
10 Feedthrough ZL-RTB20 or 

ZL-RTB20-1 ZL-P1-CBL10*
P1-4DAL2ADL-2

* �Select the cable length by replacing the * with: Blank = 0.5 m, -1 = 1.0 m, or -2 = 2.0 m.
1. These modules are not supported by the ZIPLink wiring system. 
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Removable Terminal Blocks (Optional)
The hand wiring method consists of purchasing the associated removable I/O module 
terminal block (table below) and hand wiring from the I/O terminal block to a DIN rail 
mounted terminal block.

* Recommended screw driver: P/N TW-SD-MSL-1.

Removable Terminal Block Specifications
Part Number P1-10RTB P1-10RTB-1
Number of 
Positions 10 Screw Terminals 10 Spring Clamp Terminals

Wire Range 

30–16 AWG (0.051–1.31 mm²) 
Solid / Stranded Conductor  
3/64 in. (1.2 mm) Insulation Max.
1/4 in. (6–7 mm) Strip Length

28–16 AWG (0.081–1.31 mm²) 
Solid / Stranded Conductor  
3/64 in. (1.2 mm) Insulation Max.
19/64 in. (7–8 mm) Strip Length

Conductors “USE COPPER CONDUCTORS, 75°C” or Equivalent.

Screw Driver 0.1 inch (2.5 mm) Maximum*

Screw Size M2 N/A
Screw Torque 2.5 lb·in (0.28 N·m) N/A

* Recommended screw driver: P/N TW-SD-MSL-1.

Removable Terminal Block Specifications
Part Number P2-RTB P2-RTB-1
Number of 
Positions 18 Screw Terminals 18 Spring Clamp Terminals

Wire Range 

30–16 AWG (0.051–1.31 mm²) 
Solid / Stranded Conductor  
3/64 in. (1.2 mm) Insulation Max.
1/4 in. (6–7 mm) Strip Length

28–16 AWG (0.081–1.31 mm²) 
Solid / Stranded Conductor  
3/64 in. (1.2 mm) Insulation Max.
19/64 in. (7–8 mm) Strip Length

Conductors “USE COPPER CONDUCTORS, 75°C” or Equivalent.
Screw Driver 0.1 inch (2.5 mm) Maximum*
Screw Size M2 N/A
Screw Torque 2.5 lb·in (0.28 N·m) N/A

P1-10RTB and P1-10RTB-1

P2-RTB and P2-RTB-1
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P2-RTB (screw terminals) 
Removable Terminal Block

P1-10RTB (screw terminals) 
Removable Terminal Block

P2-RTB-1 (spring-clip terminals) 
Removable Terminal Block

P1-10RTB-1 (spring-clip terminals)  
Removable Terminal Block

Removable Terminal Blocks, continued

Terminal Block Installation

Use the Wire Strip Length gauge printed on the end of the terminal strip as a guide to 
properly strip wire insulation prior to inserting into terminal block.  For ease of assembly, 
block maybe wired prior to installation, if desired.  
Insert terminal block as follows: 
Step 1:  Raise finger-safe terminal guard. 
Step 2:  Align terminal block with module terminal pins, 

ensuring correct orientation of block.
Step 3:  Firmly and evenly press terminal block onto terminal pins 

until seated.  Lower finger-safe guard into place. 
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Planning the I/O Wiring Routes
The following guidelines provide general information on how to wire the I/O connections 
to Productivity1000 modules.  For specific information on wiring a particular I/O module 
refer to the module specifications in Chapter 2.

1.	 If using removable terminal blocks, follow the wire size guidelines 
in the I/O modules specifications in Chapter 2.

2.	 Always use a continuous length of wire.  Do not 
splice wires to create a needed length.

3.	 Use the shortest possible wire length.
4.	 Use wire trays for routing where possible.
5.	 Avoid running low voltage control wires near high voltage wiring. Use 

separate conduits for lowvoltage DC and AC power/signal wiing runs.
6.	 Avoid confusion by laying input wiring separate from output wiring where possible.
7.	 To minimize voltage drops when wires must run a long distance, 

consider using multiple wires for the return line.
8.	 Avoid running DC wiring in close proximity to AC wiring where possible.
9.	 Avoid creating sharp bends in the wires; follow accepted 

Electrical Code bend allowance standards.

Terminal Block Removal

Remove terminal block as follows: 
Step 1:  Raise terminal cover. 
Step 2:  Pull terminal block release lever 

forward.  This will lift terminal 
block away from pins.  

Step 3:  Grasp block firmly and pull 
away from module. 

WARNING:  Ensure local and remote power supplies have been disconnected prior to 
removing terminal block. 

Terminal Cover

Terminal Release Lever
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System Wiring Strategies
The P1AM-100 is very flexible and will work in many different wiring configurations.  By 
studying this section before actual installation, you may find the best wiring strategy for 
your application.  This will help to lower system cost and wiring errors, and avoid safety 
problems.

CPU Isolation Boundaries
CPU circuitry is divided into three main regions separated by isolation boundaries, shown 
in the drawing below.  Electrical isolation provides safety, so that a fault in one area does 
not damage another.  The transformer in the power supply provides magnetic isolation 
between the primary and secondary sides.  Optical isolators provide isolation to input and 
output circuits.  This isolates logic circuitry from the field side, where factory machinery 
connects.   
The discrete inputs and discrete outputs are isolated from eachother and from the logic 
side.  Isolation boundaries protect the devices which are connected to the communication 
ports, such as PCs and HMIs, from power input faults or field wiring faults.  
When wiring a controller, it is extremely important to avoid making external connections 
that connect logic side circuits to any other.

ControllerShieldShieldPower Supply

Power
Input

PC

Output ModuleInput Module

Isolation Boundary

Logic Circuit Com
Ports

Input
Circuit

Input/
Output
Circuit

Output
Circuit

HMI or other
communication devices

Logic
Circuit

Logic
Circuit

Com
Ports

24VDC

Maximum 15 I/O Modules

Isolation Boundaries
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Sinking/Sourcing Concepts
Before wiring field devices to the CPU I/O, it’s necessary to have a basic understanding 
of “sinking” and “sourcing” concepts.  Use of these terms occurs frequently in input or 
output circuit discussions.  These terms only apply to DC circuits, not AC circuits.  The 
purpose of this section is to explain the terms.  The short definitions are as follows:

•	 Sinking = Path to supply ground (–) or switching ground.
•	 Sourcing = Path to supply source (+) or switching +V.

Input and output points that are either sinking or sourcing can conduct current in only 
one direction.  This means it is possible to wire the external supply and field device to the 
I/O point with current trying to flow in the wrong direction, in which case the circuit will 
not operate.

The diagram on the left shows a “sinking” CPU input. 
To properly connect the external supply, connect it 
so that the input provides a path to ground (–).  Start 
at the CPU input terminal, follow through the input 
sensing circuit, exit at the common terminal, and 
connect the supply (–) to the common terminal.  
The switch between the supply (+) and the input 
completes the circuit.  Current flows in the direction 
of the arrow when the switch is closed.  By applying 

the circuit principle above to the four possible combinations of input/output sinking/
sourcing types, we have the four circuits as shown below.

+

–

Input
Sensing 

CPU
 

Common

Input
(sinking)

+

–

 
Input 
Sensing 

Load

Sinking Input Sinking Output

Sourcing Input Sourcing Output

CPU
Input

Common

+

–

 
Output
Switch

CPU
Output

Common

+

–

Input 
Sensing 

Load

CPU

Input

Common

+

–

 
Output
Switch

CPU

Output

Common
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I/O “Common Terminal” Concepts
In order for a CPU I/O circuit to operate, current must enter at one terminal and exit at 
another.  This means at least two terminals are associated with every I/O point.  In the 
figure below, the input or output terminal is the main path for the current.  One additional 
terminal must provide the return path to the power supply.
If there was unlimited module space then every I/O point could have two dedicated 
terminals as the figure above shows.  Providing this level of flexibility is not practical or 
necessary for most applications.  Most I/O point groups share the return path (common) 
among two or more I/O points.  The figure below shows a group (or bank) of four input 
points which share a common return path.  In this way, the four inputs require only five 
terminals instead of eight.

+

–

I/O
 Circuit

 

Return Path
 

 Main Path
(I/O point)

Field
Device

CPU

+

–

 Input Sensing

 

Input 4

Common

Input 3

Input 2

CPU

Input 1

 

Electrical Common 
To All Input Points

NOTE: In the circuit above, the current in the common path is equal to the sum of the energized 
channels.  This is especially important in output circuits, where larger gauge wire is sometimes 
needed for the commons.
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DC Input Wiring Methods
I/O modules with DC inputs can be wired as either sinking or 
sourcing inputs.  The dual diodes (shown in this diagram) allow 
current to flow in either direction.  Inputs grouped by a common 
point must be either all sinking or all sourcing.  DC inputs typically 
operate in the range of +12–24 VDC.

Sinking Input Sensor (NPN Type) to CPU Sourcing Input
In the following example, a field device has an open-collector NPN transistor output.  When 
energized, it sinks current to ground from the DC input point.  The CPU input current is 
sourced from the common terminal connected to power supply (+). 

Sourcing Input Sensor (PNP Type) to CPU Sinking Input
In the following example, a field device has an open-emitter PNP transistor output.  When 
energized, it sources current to the CPU input point, which sinks the current to ground.  
Since the field device loop is sourcing current, no additional power supply is required for 
the module.

DC Output Wiring Methods
I/O modules with DC output circuits are wired as all current sinking only or current sourcing 
only depending on which output module part number is used.  DC outputs typically 
operate in the range of +5 to +24 VDC.
CPU Sinking Output to Sourcing Load Device
Many applications require connecting a CPU output point to a DC input on a field device 
load. This type of connection is made to carry a low-level DC signal.
In the following example, the CPU output point sinks current to ground (common) when 
energized.  The output is connected to a field device load with a sourcing input.

CPU DC Input

Common

Input

Field Device

Output (sourcing)

Ground Common

 

Input
 (sinking)

 

DC PNP Sensor 
(Sourcing) CPU Input 

(Sinking)

Field Device

+–

CPU DC Input
Output

Ground Common
Supply

(sinking)
Input

(sourcing)DC NPN Sensor 
(Sinking)

CPU Input 
(Sourcing)

Field DeviceCPU DC Output
+DC Power

+

–

Power

20-28 VDC

Output
(sinking)

Common

Input
(sourcing)

Ground

DC Load 
(Sourcing)

CPU Output 
(Sinking)
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CPU DC Sinking Output to Sinking Load Device
In the example below, a sinking output point is connected to the sinking input of a 
field device load. In this case, both the CPU output and field device input are sinking 
type.  Since the circuit must have one sourcing and one sinking device, we add sourcing 
capability to the CPU output by using a pull-up resistor.  In the circuit below, we connect R 
pull-up from the output to the DC output circuit power input.

NOTE: DO NOT attempt to drive a heavy load (>25mA) with this pull-up method. 

NOTE: Using the pull-up resistor (Rpull-up) to implement a sourcing output has the effect of 
inverting the output point logic.  In other words, the field device input is energized when the CPU 
output is OFF, from a ladder logic point-of-view.  Your ladder program must comprehend this and 
generate an inverted output.  Or, you may choose to cancel the effect of the inversion elsewhere, 
such as in the field device.

It is important to choose the correct value of Rpull-up.  In order to do so, we need to know 
the nominal input current to the field device (Iinput) when the input is energized.  If this 
value is not known, it can be calculated as shown (a typical value is 15mA).  Then use Iinput 
and the voltage of the external supply to compute Rpull-up.  Then calculate the power 
Ppull-up (in watts), in order to size Rpull-up properly.

Field Device

Output

Ground

Input

Common

CPU DC Output

+DC pwr

+

–

(sourcing)

(sinking)

Power

(sinking)

pull-up

Supply

R

inputR

CPU Output 
(Sinking with  

Pull-up Resistor)

DC NPN Load 
(Sinking)

pull-upR inputR=
supplyV – 0.7

–
inputI

inputI =
input (turn–on)V

inputRR

pull-upP =
supplyV 2

pull-upR
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Relay Outputs - Wiring Methods
Relay outputs are available for the ProductivityOpen.  Relays are best for the following 
applications:

•	 Loads that require higher currents than the solid-state outputs can deliver
•	 Cost-sensitive applications
•	 Some output channels need isolation from other outputs (such as when some 

loads require different voltages than other loads)
Some applications in which NOT to use relays:

•	 Loads that require currents under 10mA
•	 Loads which must be switched at high speed or heavy duty cycle.

Relay outputs are available in two contact arrangements.  
Form A type, or SPST (single pole, single throw) type.  
They are normally open and are the simplest to use.  The 
Form C, or SPDT (single pole, double throw) type has a 
center contact which moves and a stationary contact on 
either side.  This provides a normally closed contact and a 
normally open contact.

The relays in some relay output modules share common 
terminals, which connect to the wiper contact in each 
relay of the bank.  Other relay modules have relays which 
are completely isolated from each other.  In all cases, 
the module drives the relay coil when the corresponding 
output point is on.

Relay with Form A contacts

Relay with Form C contacts
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Relay Outputs – Transient Suppression for Inductive Loads  
in a Control System

The following pages are intended to give a quick overview of the negative effects of 
transient voltages on a control system and provide some simple advice on how to 
effectively minimize them.  The need for transient suppression is often not apparent to the 
newcomers in the automation world.  Many mysterious errors that can afflict an installation 
can be traced back to a lack of transient suppression.
What is a Transient Voltage and Why is it Bad?
Inductive loads (devices with a coil) generate transient voltages as they transition from 
being energized to being de-energized.  If not suppressed, the transient can be many times 
greater than the voltage applied to the coil.  These transient voltages can damage CPU 
outputs or other electronic devices connected to the circuit, and cause unreliable operation 
of other electronics in the general area.  Transients must be managed with suppressors for 
long component life and reliable operation of the control system.
This example shows a simple circuit with a small 24V/125mA/3W relay.  As you can see, 
when the switch is opened, thereby de-energizing the coil, the transient voltage generated 
across the switch contacts peaks at 140V. 

In the same circuit, replacing the relay with a larger 24V/290mA/7W relay will generate a 
transient voltage exceeding 800V (not shown).  Transient voltages like this can cause many 
problems, including:

•	 Relay contacts driving the coil may experience arcing, which can pit the contacts 
and reduce the relay’s lifespan.

•	 Solid state (transistor) outputs driving the coil can be damaged if the transient 
voltage exceeds the transistor’s ratings.  In extreme cases, complete failure of 
the output can occur the very first time a coil is de-energized.

•	 Input circuits, which might be connected to monitor the coil or the output 
driver, can also be damaged by the transient voltage.

A very destructive side-effect of the arcing across relay contacts is the electromagnetic 
interference (EMI) it can cause.  This occurs because the arcing causes a current surge, 
which releases RF energy.  The entire length of wire between the relay contacts, the coil, 
and the power source carries the current surge and becomes an antenna that radiates the 
RF energy.  It will readily couple into parallel wiring and may disrupt the CPU and other 
electronics in the area.  This EMI can make an otherwise stable control system behave 
unpredictably at times. 

Oscilloscope

Relay Coil
(24V/125mA/3W, 
AutomationDirect part no.
750R-2C-24D)

24 VDC
+

-

160
140
120

100

40
20

-20

Volts

80
60

0

Example: Circuit with no Suppression
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CPU’s Integrated Transient Suppressors
Although the CPU outputs typically have integrated suppressors to protect against 
transients, they are not capable of handling them all.  It is usually necessary to have some 
additional transient suppression for an inductive load.
Here is another example using the same 24V/125mA/3W relay used earlier.  This example 
measures the PNP transistor output of a typical CPU, which incorporates an integrated 
Zener diode for transient suppression.  Instead of the 140V peak in the first example, the 
transient voltage here is limited to about 40V by the Zener diode.  While the CPU will 
probably tolerate repeated transients in this range for some time, the 40V is still beyond 
the module’s peak output voltage rating of 30V.

Relay 
Coil*

24
VDC

Oscilloscope

* For this example, a 24V/125mA/3W 
relay is used (AutomationDirect 

part no. 750R-2C-24D)

45

40

35

30

15

10

0

-5

Volts

25

20

5

Example: Small Inductive Load with Only Integrated Suppression

The next example uses the same circuit as above, but with a larger 24V/290mA/7W relay, 
thereby creating a larger inductive load.  As you can see, the transient voltage generated is 
much worse, peaking at over 50V.  Driving an inductive load of this size without additional 
transient suppression is very likely to permanently damage the CPU output.

Example: Larger Inductive Load with Only Integrated Suppression

Relay 
Coil*

Oscilloscope

* For this example, a 24/290mA/7W 
relay is used (AutomationDirect 

part no. SC-E03G-24VDC)

60

50

40

30

20

10

0

-10

Volts

Additional transient suppression should be used in both of these examples.  If you are 
unable to measure the transients generated by the connected loads of your control 
system, using additional transient suppression on all inductive loads would be the safest 
practice.
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Types of Additional Transient Protection
DC Coils:
The most effective protection against transients from a DC coil is a flyback diode.  A flyback 
diode can reduce the transient to roughly 1V over the supply voltage, as shown in this 
example. 

Oscilloscope

24 VDC

DC Flyback Circuit

Sinking Sourcing

+
_
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Many AutomationDirect socketed relays and motor starters have add-on flyback diodes 
that plug or screw into the base, such as the AD-ASMD-250 protection diode module and  
784-4C-SKT-1 socket module shown below.  If an add-on flyback diode is not available for 
your inductive load, an easy way to add one is to use AutomationDirect’s DN-D10DR-A 
diode terminal block, a 600VDC power diode mounted in a slim DIN rail housing.

DN-D10DR-A
Diode Terminal Block

AD-ASMD-250
Protection Diode Module

784-4C-SKT-1 
Relay Socket
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ZL-TSD8-24 
Transorb Module

AC Coils:
Two options for AC coils are MOVs or bi-directional TVS diodes. These devices are most 
effective at protecting the driver from a transient voltage when connected across the driver 
(CPU output) but are also commonly connected across the coil.  The optimum voltage 
rating for the suppressor is the lowest rated voltage available that will NOT conduct at the 
supply voltage, while allowing a safe margin.
AutomationDirect’s ZL-TSD8-120 transorb module is a good choice for 120VAC circuits.  It 
is a bank of eight bi-directional 180V TVS diodes.

ZL-TSD8-120
Transorb Module

NOTE: Manufacturers of devices with coils frequently offer MOV or TVS diode suppressors as an 
add-on option which mount conveniently across the coil.  Before using them, carefully check the 
suppressor ratings.  Just because the suppressor is made specifically for that part does not mean it 
will reduce the transient voltages to an acceptable level. 

For example, a MOV or TVS diode rated for use on 24-48 VDC coils would need to have a 
high enough voltage rating to NOT conduct at 48V.  That suppressor might typically start 
conducting at roughly 60VDC.  If it were mounted across a 24V coil, transients of roughly 
84V (if sinking output) or -60V (if sourcing output) could reach the CPU output.  Many 
semiconductor CPU outputs cannot tolerate such levels.

Two more common options for DC coils are Metal Oxide Varistors (MOV) or TVS diodes. 
These devices should be connected across the driver (CPU output) for best protection as 
shown below.  The optimum voltage rating for the suppressor is the lowest rated voltage 
available that will NOT conduct at the supply voltage, while allowing a safe margin. 
AutomationDirect’s ZL-TSD8-24 transorb module is a good choice for 24VDC circuits.  It 
has a bank of 8 uni-directional 30V TVS diodes.  Since they are uni-directional, be sure to 
observe the polarity during installation.  MOVs or bi-directional TVS diodes would install at 
the same location, but have no polarity concerns.

24 VDC

DC MOV or TVS Diode Circuit

Sinking Sourcing

+
_

VAC

AC MOV or Bi-Directional Diode Circuit
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Security Considerations for Control Systems Networks
Manufacturers are realizing that to stay competitive, their Automation and Control Systems 
need to be more integrated within their plant. The systems often need to be integrated 
with upstream Enterprise Data Systems, and even further integrated to allow information to 
be accessible across multiple plants, or even through the Internet. This convergence of the 
IT world with the Automation World creates challenges in maintaining secure systems and 
protecting your investments in processes, personnel, data and intellectual property.
While Automation Networks and Systems have built-in password protection schemes, this 
is only one very small step in securing your systems. Automation Control System Networks 
need to incorporate data protection and security measures that are at least as robust as a 
typical business computer system. We recommend that users of PLCs, HMI products and 
SCADA systems perform your own network security analysis to determine the proper level 
of security required for you application. However, the Department of Homeland Security’s 
National Cybersecurity and Communications Integration Center (NCCIC) and Industrial 
Control Systems Cyber Emergency Response Team (ICS-CERT) has provided direction related 
to network security and safety under an approach described as “Defense in Depth”, which is 
published at https://ics-cert.uscert.gov/sites/default/files/recommended_practices/NCCIC_
ICSCERT_Defense_in_Depth_2016_S508C.pdf. 
This comprehensive security strategy involves physical protection methods, as well as 
process and policy methods. This approach creates multiple layers and levels of security 
for industrial automation systems. Such safeguards include the location of control system 
networks behind firewalls, their isolation from business networks, the use of intrusion 
detection systems, and the use of secure methods for remote access such as Virtual Private 
Networks (VPNs). Further, users should minimize network exposure for all control system 
devices and such control systems and these systems should not directly face the internet. 
Following these procedures should significantly reduce your risks both from external 
sources as well as internal sources, and provide a more secure system.
It is the user’s responsibility to protect such systems, just as you would protect your 
computer and business systems. AutomationDirect recommends using one or more of these 
resources in putting together a secure system:

•	 US-CERT’s Control Systems Security Program at the following web address:  
www.us-cert.gov/control_systems/

•	 Special Publication 800-82 of the National Institute of Standards and Technology 
– Guide to Industrial Control Systems (ICS) Security 
https://csrc.nist.gov/publications/detail/sp/800-82/rev-2/final

•	 ISA99, Industrial Automation and Control Systems Security  
http://www.isa.org/MSTemplate.cfm?MicrositeID=988&CommitteeID=6821  
(please note this is a summary and these standards have to be  
purchased from ISA)

The above set of resources provides a comprehensive approach to securing a control 
system network and reducing risk and exposure from security breaches. Given the nature of 
any system that accesses the internet, it is incumbent upon each user to assess the needs 
and requirements of their application, and take steps to mitigate the particular security risks 
inherent in their control system.
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